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Chapter 1: Fundamentals

Exercise: Checking out Excel

Before you start, be sure that your computer is on and Windows is running. You'll start Excel and take a look
around its interface.

Do This How & Why

1. Follow your instructor's directions to The method you use depends on your version of Windows and
start Excel. how it is set up. In Windows 10, you can simply click the
Excel icon on the taskbar at the bottom of the screen, or click
Start > All Apps and then click the Excel 2016 tile.

2. Click Blank workbook. To open a new, blank workbook.
3. Observe the Excel window. Most of the window is taken up by a worksheet, which is just a
grid of cells.
4. Observe the column letters and row The column letters identify the columns in an Excel workbook.
numbers. They start at A, go to Z, then start again with AA to AZ, BA to

BZ, and so on. There are 16,384 columns in an Excel
worksheet, the last one being column XFD. The rows are
numbered, and therc arc well over a million of them. The rows
and columns intersect to form cells, which is where you enter
and view data.

5. Observe the ribbon. This is the large area of buttons, lists, menus, and palettes at
the top of the window. It's organized into tabs (File, Home,

Insert, and so on), and within in a tab, into groups.

6. Observe the Home tab. It contains the most common commands, and is organized into
groups (Clipboard, Font, Alignment, and so on).

7. Point to the Bold button. To display a screen tip, explaining what the tool does.

Insert

Page Layout
Calibri -1

nter B%I u - .
F

Font

Bold (Ctrl+B)
Make your text bold.

C F)

8. Observe the Quick Access toolbar. This is the small toolbar at the top left. It has just a few of the
most useful commands. You can customize it however you

like.

9. Observe the formula bar. The formula bar is essentially an editing arca for the data in a
worksheet. Excel has many features to make data entry simple.
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Chapter 1: Fundamentals

Exercise: Opening and moving through a workbook

Excel is open and the sample data files for this exercise are accessible. In this exercise, you'll open a
workbook containing invoice data and reports on that data, and learn to move around using various keyboard

and mouse techniques.

Exam Objective: MOS Exccl Core 1.2.2, 1.4.7

Do This

How & Why

1. Click the File tab.

To display Excel's Backstage view. This is the one ribbon tab that takes you off the ribbon. Backstage
view is where you perform actions on files or change settings for workbooks, worksheets, or Excel
itself. By default, the Open screen appears, giving you options for opening workbooks. If you've
recently opened some workbooks, you'll see them listed here.

Open
|!- ::1 Recent

(& OneDrive

=t

FC1 ThisPC
ke

Is

Add a Place

Browse

You haven't opened any workbooks recently. Pick a place to
browse for a workbook.

2. Click Browse.

3. Navigate to the current data folder.

4. Sclect Invoice Data, and click Open.

5. Observe the workbook.

6. Click cell A6.

7. Observe the Name box.

On the left, under Open in the list of places. Excel's Open
window appears.

Click This PC on the left, then usc the list on folders and files
on the right. The folder is called "Fundamentals." Your
instructor can help you.

It contains invoice data for Java Tucana's sales of boxes of
individual servings of coffees and teas for offices. Each row
represents one invoice, showing the customer, sales
representative, sales region, product, quantity, and amount.

To select the cell and make it active. This cell contains a label,
"Datc," that identifics the data in the column below.

In the upper left. It shows the address of the active cell, which
is the column letter followed by the row number.

AB »

10
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Module B: Workbook basics

Do This

How & Why

8. Experiment with the arrow keys.

9. Drag over a range of cells.

10. Press Ctrl+Home.

11. Press Ctrl+End.

12. Press Ctrl+Right Arrow, then
Ctrl+Down Arrow.

13. Experiment with the scroll bars.

14. Experiment with the Zoom control,
and then return to 100%
magnification.

15. Click the Reps worksheet tab.
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17. Press Ctrl+Page Up.

18. Return to cell Al on the Invoices
worksheet.

Excel 2016 Level 1

Pressing an arrow key moves the active cell one row or
column in the direction of the arrow.

To select them. Dragging selects a range, which is a
rectangular block of cells. You refer to a range by its upper-left
and lower-right comer cells, separated by a colon. For
example, A2:C4.

To make cell Al active. This can be very handy when you're
far from home.

To move to the last cell that contains data, cell H1004. This
worksheet has about 1,000 rows of data. That might seem like
a lot, but a worksheet can contain far more.

To move to the last cell in the worksheet. A worksheet has over
16,000 columns and over a million rows. That's room for a
great deal of data.

The scroll bars allow you to move your view of the worksheet
without moving the active cell. The arrows at the top and
bottom of the vertical scroll bar move on row up or down,
while the arrows to the left and right of the horizontal scroll
bar move one column left or right. Dragging the scroll boxes
lets you move your view quickly.

The zoom control is in the lower-right corner of the Excel
window. You drag it to change the level off maginfication in
the workbook.

- | +  100%

At the bottom of the screen. To activate the Reps worksheet.
This worksheet contains a type of Excel report called a
PivotTable which summarizes data by sales rep from the large
list of invoices.

A3
Customer.

To move one worksheet up in the stack. The Reps worksheet is
now active.

Activate the worksheet by clicking its tab, then press
Ctrl+Home.

1



Module B: Workbook basics

Exercise: Finding information in a workbook

The Invoice Data workbook is open, and the Invoices worksheet 1s active.

Exam Objective: MOS Excel Core 1.2.1,1.2.2

Do This How & Why
1. On the Home tab, in the Editing group, 3 AutoSum * Acy p
click Find & Select. [T Fill - =

Sort & Find &

£ Clear~ Filter ~ SeIe(Tg
Editing

These commands help you find data and move to certain
places in the worksheet.

2. Click Go To. You can also press F5. To display the Go To window. You can
select a location or enter a reference to a cell you want to
select.

3. In the Reference box, type H1004, To select cell H1I004, the last cell in the worksheet that

then click OK. contains data.

4. Find an invoice that is associated with
the Rep named "Franklin."

a) Click Find & Select, then click

Find.
b) In the Find what box, type
Franklin.
¢) Click Find Next. To find the first instance of the rep name, "Franklin." Note that
the Find & Replace window remains open.
5. Click Find Next. To find another instance of the text, "Franklin," in the
worksheet.
6. Click Close. To close the Find & Replace window.

Excel 2016 Level 1 13



Chapter 1: Fundamentals

Entering data

Entering and editing data is most of what you do in Excel. There are many kinds of data: numbers, text, dates,
and formulas, for example. But the basics of entering data are always the same.
1. Select the cell or range where you want to enter data.

2. Type the data you want to enter.
3. Press Enter or click the Enter box (the check mark) on the formula bar.

X W J 15

Exercise: Entering data in a cell
The Invoice Data workbook is open, and the Invoices worksheet is active.

Do This How & Why

1. Select cell C9. Lloyd is not the correct sales representative for this invoice, so
you will change the data.

2. Type Mc and observe the screen. Several things happen as Excel goes into editing mode. What
you type is beginning to show up in the cell as well as on the
formula bar. Excel is also guessing that you want to enter a
name that is already in this column, "McCanney."

C9 fd X « K McCanney

A B C D

Java Tucana

ohooLn e W

7 | 10/14/2014 Red Rock Mountain Tours Hernandez Eurozone

8 | 3/17/2014 BlazerFire Daniels us
9 | 8/15/2015 Managec Group |McCanney linternaticg
10 _8/23/ 2014 CrossCo ry Alfwa Danie US

3. Press Enter. To accept "McCanney" as what you want to enter in the cell.
4. Select cell F9. This 1s the Units data for the same invoice. You'll change this
number.

5. Type 15 and observe the formula bar. ~ When you are entering data in a cell, the formula bar gives you
options for what to do with what you are entering.

b v K 15

v To enter the new units figure. The Enter button is on the
- formula bar. You also could have pressed Enter.

6. Click

14 Excel 2016 Level 1



Module B: Workbook basics

Exercise: Saving and closing a workbook

The Invoice Data workbook is open, and you've made changes to it in a previous exercise. You'll save the
changes you made to the Invoice Data workbook and then close it.

Do This

How & Why

1. Click File.

2. Click Save As.

3. On the right, under Current Folder,
click Fundamentals.

4. Change the file name to My
Invoice Data.

5. Click Save.

6. Change the product in cell E9 to Vela
Herbal.

7. Click E :

8. Click File.

9. Click Close.

To display Backstage view. This is where you save, print, and
perform other actions on workbooks and files.

To display locations to which you can save the workbook.

To display the Save As window, with the Fundamentals folder
selected. Here, you can change the name, location, or type of
file for the workbook. When you open a file, the first save
location you wee will always be the currently folder.

Click in the File Name box, and simply add the word "My" at
the beginning. You can edit text in this box as you would

anywhere in Windows.

Note that the title bar now displays the new name of the
workbook.

My Invoice Data - Excel

Select the cell, type "Vela Herbal," and press Enter. Just to
make a change in the workbook.

To save, or update, the file in the current location with the
current name. Excel has an automatic saving feature, but it's
safest to save periodically so you don't lose any work.

To display Backstage view.

To close the workbook.

Excel 2016 Level 1
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Module A: Entering data

Do This How & Why

¢) Press Enter.
4. In cell A4, enter Rent. Select cell A4, type "Rent," and press Enter. This is the first
category of budget item. Notice that Excel left-aligns text by

default. You can control alignment, though.

5. Enter labels in column A as shown. These labels identify the categories of expenses.

A B
3 |Category
4 |Rent
5 |Remadeling
6 |Legal
7 |Equipment
8 |Supplies
g |Advertising
10 |Payroll
11 |Miscellaneous
12 |Totals:

6. Widen column A.

a) Observe cell All. The text spills into column B. That's fine now, but won't be
when you put figures in that column.

b) Point to the border between column  The pointer looks like a two-headed arrow.

headings A and B. S
3 |Category |
4 |Rent
c¢) Drag the border to the right. To widen the column enough to fit all the labels.
7. Enter labels in row 3 as shown. These are the year labels for the budget.

A B C

3 |Category Yearl  Year2

4 |Rent

8. Save the workbook as My Cafe
Budget inthe Creating
Workbooks folder.

a) Click File, then click Save.

b) Click Browse, then navigate to the  Your instructor can help you find it.
Creating Workbooks data folder.

¢) In the File name box, type My
Cafe Budget.

d) Click Save.

Excel 2016 Level 1 25



Chapter 2: Creating worksheets

Entering numbers

You enter numbers the same way you enter any other data, by selecting a cell and typing. The main difference
between text and numbers is that Excel can perform calculations on numbers (you can manipulate text as
well, though). If you enter a number that has too many digits to display in a cell, Excel handles that in one of
a few ways. You might see number signs rather than a partial number, which would be misleading.

B4 x S 972861069729873

A B 2 D E
3 |Category Year 1l Year 2
4 |rent [sessassnn]

5 |Remodeling

In that case, you can simply widen the cell. If you enter a very large number, Excel might display it in
scientific notation:

B4 - f 2000000000000000000
A B e D E

3 |Category Yearl Year 2

4 |Rent 2e+18]

5 |Remodeling

Scientific notation expresses a large number as a small one multiplied by 10 raised to a particular power.
Here, Excel represented 2,000,000,000,000,000,000 as 2 times 10,

If you enter a number with too many decimals to display, Excel rounds off the display, but does not actually
round the stored number. Excel also allows you great control over the display of numbers.

By default, Excel right-aligns numbers, which allows them to line up better in a column.

Entering data in a range
You can select a whole range and then quickly enter data in that range.

1. Select the range in which you want to enter the data.
2. Type the data for the first cell, and then press Enter or Tab.

3. Continue until you've entered all the data you want.

Exercise: Entering numbers in a workbook
The My Cafe Budget workbook is open, and category and year labels have been entered.

Do This How & Why
1. In cell B4, enter 24000. Select cell B4, type 24000, and press Enter. To enter a Year 1
roant fionre in the huidoet
rent figure in the budget.
2. Observe cell B4. The number appears right-aligned in the cell.
3. Select the range B5:B11. To prepare to enter numbers in the rest of the range. Notice

that the range is highlighted, indicated that it is selected. But
only the first cell, B5, is active.

4. Type 1200 and press Enter. To enter a Year 1 remodeling budget figure and to move the
active cell to B6.

26 Excel 2016 Level 1



Module A: Entering data

Do This

5. Enter the rest of the Year 1 budget
figures as shown.

6. Click E :

7. Close the workbook.

Assessment: Entering data

How & Why

3 |Category Yearl

4 |Rent 24000
5 Remodeling 1200
6 |Legal 5000
7 |Eguipment 9000
8 |Supplies 12000
g |Advertising 4000
10 |Payroll 60000
11 |Miscellaneous 10000

To save the workbook with its current name in its current
location. You could instead press Ctrl+S, or click Save in
Backstage view.

Click File, then click Close.

By default, Excel left-aligns all data that you enter. True or false?

* True

* False

How does Excel handle text that is too wide for the column in which it appears?

* By cutting it off at the right-hand border of the cell.

* By spilling the text over into the next column.

* It depends on what is in the next cell to the right.

You can change the width of a column by using the mouse. True or false?

* True

* False

Which of the following are ways that Excel handles numbers that are too wide for a cell? Choose all that

apply.
* Scientific notation
*  Binary
*  Number signs (####)

*  Rounding the stored number

Excel 2016 Level 1
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Chapter 2: Creating worksheets

Exercise: Performing calculations with formulas

In this exercise, you'll open the framework of a café budget, and then enter simple formulas to calculate totals
and monthly figures.

Exam Objective: MOS Excel Core 4.1.1

Do This How & Why
1. Open Formula Basics. It is in the Creating Worksheets data folder. The first
worksheet in the workbook has labels and some values for a
café budget.

2. Enter a total formula in DS.

a) Select cell DS. You'll enter a formula to total the Year 1 and Year 2 rent
values.

b) Type =. To begin to enter a formula. All formulas start with any equal
sign.

¢) Type BS. This is the cell reference for the Year 1 rent value. Always use

cell references in formulas, if you can. Notice that after you
type the reference, Excel highlights the cell.

d) Type +C8. The formula will add the value cell B8 to the value in cell C8.
Excel highlights C8 in a different color. In this way, Excel lets
you see all the cells or ranges to which your formula refers.

¢) Press Enter. To enter the formula. The cell now displays the correct total,
48000.
3. Sclect DS. The cell displays the result, but if you look at the formula bar,
you see the formula that you entered.
D8 o | =B8+CB
A B C D
7 Expense Yearl Year2 Total

8 [rent 24000 24000( _ as000|

4. How would you calculate the monthly ~ You would divide the two-year total by 24, the number of
average rent? months in two years.

5. In E8, enter the correct formula.
a) Select E8 and type =.
b) Click cell DS. To enter a reference to it in the formula you are creating. You
can enter references using the mouse, and it's often much

casier to do it that way.

¢) Type /24.

30 Excel 2016 Level 1
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Module B: Formulas

Do This

How & Why

d) Enter the formula.

6. Enter the total and monthly formulas
for remodeling.

7. Save the workbook as My Formula
Basics.

8. In C9, enter 4000.

9. Save the workbook.

Order of operations

Either by pressing Enter or clicking the Enter button on the
formula bar. The average monthly rent for the first two years is

2000.

The worksheet should look like this when you finish. You
could enter the rest of the formulas in the same manner, but
you'll be learning better ways.

ES

7|

= "
I'\

=D9/24

_B_ C L D E
Yearl Year2 Total Monthly

5

24000 24000 48000 2000

12000 2000 14600' 583.33331

To change the Year 2 remodeling expense figure. Notice that
the formulas in cells D9 and E9 display updated values. This is
the power of using formulas that operate on cell references.

7 |

B C D E

Yearl Year2 | Total .Ml}nthly

9

8 {

24000 24000 48000 2000
12000 4000 16000 666.6667

Click the Save button.

Excel evaluates the operations in a formula according to its order of operations. If you remember a bit of
basic algebra, this will be familiar to you. The order is summarized in the following table.

Order of operations

Order Operation ‘Operator Example
1 Parentheses 0 =3*(A2+A3)
2 Negation - =2
3 Percentage % =25%

L -

4 Exponents A =A4"2
5 Multiplication * =A2*A3
5 Division / =A2/A3
6 Addition + =A2+A3
6 Subtraction - =A2-A3

Excel 2016 Level 1
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Module B: Formulas

Exercise: Controlling the order of operations

The My Formula Basics workbook is open. You'll experiment with the order of operations in Excel formulas.

Exam Objective: MOS Excel Core 4.1.2

Do This

How & Why

1.

Click the Order of Operations
worksheet tab.

Observe Al1:D2.

In D2, enter =A2+B2/C2.

Revise the formula to read
=(A2+B2) /C2.

a) Select D2, and click in the formula
bar.

b) Insert parentheses as shown.

¢) Enter the formula.

Observe F1:H2.

. In H2, enter =8 %*F2+G2.

Revise the formula to read
=8%* (F2+G2) .

Save and close the workbook.

To activate the worksheet. The worksheet tabs are at the
bottom of the window. This worksheet has some very simple
sample data for experimenting with the order of operations.

This range contains a cost for an order of boxes, a cost for an
order of wrapping paper, and the number of wrapped boxes
that resulted from those orders. You'll calculate the average
cost per wrapped box.

To calculate the average cost. This seems like a reasonable
formula, but it gets the wrong result, 2.75, because Excel
evaluates the division (B2/C2) before the addition. You want to
evaluate the addition first.

To begin to edit the formula.

fx =A2+B2/C2

£ D

Cost | Wrapped Boxes Cost per Wrapg
3| 4l=p2+B2/C2

Click where you want each character, then type it. If you make
a mistake, press Esc and start again.

e
={A2+B2)/C2

Now, the calculation is correct (1.25).

Here, you see the costs of two items. In cell H2, you'll enter a
formula to calculate the tax, at a rate of 8%, on both items.

The result, 8.32, is incorrect. Excel first converts 8% to .08,
then multiplies it by the value in F2. You need to force Excel
to add F2 and G2 first.

Now the formula shows the correct result, 0.96.

Excel 2016 Level 1
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Chapter 2: Creating worksheets

Entering functions

Excel provides many tools to help you enter functions. The basic process works like this.

Exam Objective: MOS Excel Core 4.2.1

1. Select the cell where you want the function.

2. Type = and begin to type the name of the function.

As you begin to type letters, Excel displays a list of function names from which you can choose. If

you're editing on the formula bar, the list appears there rather than next to the cell.

A B &

16| Totals:lzsum I

o) SUMIF
=) SUMIFS

) SUMPRODUCT
) SUMSQ

o) SUMN2ZMY2

o) SUMX2PY2

o) SUNXMY2

ra
o

D

Adds all the numbers in a range of cells

E

F

3. Finish typing the name of the function by typing an opening parenthesis, or select the name from the list,

and press Tab.

Excel displays a tip box showing you what kinds of arguments the function expects. Required
arguments are bold, while optional ones aren't. The SUM() function, for example, requires at least one

number argument but can take many more, if you like.

A B C

16| Totals:lzsum( ‘|

10

D

1T SUMi{number1, [number2], ...)

4. Enter the arguments for the function.

* Type values or cell references.

* Click cells or drag over ranges to enter references to them.

» Separate arguments by typing a comma.

5. Type a closing parenthesis, then press Enter.

If you've entered a valid function with valid arguments, it will be entered and the result will appear in the cell.
If you've entered an invalid function, Excel might prompt you to fix it before you can enter it, or you might

see an error value in the cell.

= —

Exercise: Using functions to calculate sums and averages

In this exercise, you'll open a budget workbook and enter functions to calculate totals and averages.

Do This

@ Exam Objective: MOS Excel Core 4.1.2,4.1.5
How & Why

1. Open Budget Functions.

2. In B16, enter the correct SUM()
function.

From the Creating Workbooks data folder. This workbook
contains the sample cafe budget figures for five years.

36
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Module C: Functions

Do This

How & Why

a) Select cell B16 and type =.

b) Type sum.

¢) Type (.

d) Type B8:B15.

¢) Type ) and press Enter.

. In C16, enter the SUM() function.

a) In C16, type =sum (.

b) Select C8:C15.

¢) Type ) and press Enter.

4. In G8, enter the correct AVERAGE()

function.

a) Select G8, click the formula bar,
and type =av.

b) In the list, click AVERAGE, then
press Tab.

¢) Enter B8 : F8 as the argument.
d) Complete and enter the function.

. Save the workbook as My Budget
Functions.

Excel 2016 Level 1

To begin to enter the function.

As you type, Excel displays a list of functions that begin with
the letters "sum." You can simply type the whole function
name, or select it from this list.

The open parenthesis signals that you have completed the
function name and will now enter arguments for the function.

The function will calculate the total Yearl expenses.

To complete the function. The closing parenthesis is the last
piece of every function, enclosing the arguments. The cell
displays the correct total, 136000.

The name of the function and the opening parentheses. You'll
enter the argument with the mouse this time.

To enter a reference to that range as the argument for the
SUM() function. In most cases, this is much easier and more
accurate than typing the reference.

Yearl Year2 Year3 Year
24000 24000 24000 25
12000 2000 2000 2

5000 5001 300

3000 1000 1000 2
12000 13200 14500 1608

4000 1000, 1200 1
60000 65000 80000 90
10000 11090 12000 13
136000 =sum({C3:C15]

‘SUI‘-.‘Lnum-beﬂ [number2], ...)

To complete and enter the function.

This time, you'll enter the function on the formula bar. Excel
displays a list of functions beginning with "av."

Notice that when you use this method, Excel inserts the
opening parenthesis for you.

Either by typing or by using the mouse.

Type the closing parenthesis and press Enter.
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Module C: Functions

5. Enter the arguments you want.

You can type in the argument boxes or use the mouse. If the window is in the way, use the collapse

buttons to make it smaller.

6. Click OK.

Exercise: Inserting a function

The My Budget Functions workbook is open. You'll calculate an average by using the Insert Function feature.

Do This

How & Why

1. Clear the contents of G8.

2. Sclect G8, then, on the formula bar,

click L &

3. Search for AVERAGEY().

a) In the Scarch for a function box,
type average.

b) Click Go.

4. In the Sclect a function list, click
AVERAGE.

5. Click OK.

6. Click OK.

7. Save the workbook.

Select G8 and press Delete. You're going to enter the function
in a different way.

To display the Insert Function window.

To display a list of functions relating to averages.

The window shows a description of the selected function.

Select a function:

AVERAGE
AVERAGEIF
AVERAGEIFS
AVERAGEA
ZIEST
DAVERAGE
DCOUNTA

AVERAGE(numberf,number2,...)
Returns the average (arithmetic mean] of its arguments, which can be
numbers or names, arrays, or references that contain numbers,

To display the Function Arguments window. Here, you can
enter arguments in a variety of ways. The window also tells
you what kind of argument is expected (number, text, etc.).
Notice that Excel has correctly guessed that you want to use
the range of values immediately to the left (B8:F8). If it
guessed wrong, you can type a reference or use the mouse to
cnter onc.

AVERAGE

Number! |B&:Fg

MNumber2

The correct formula is entered and the result, 24480, appears
i the cell.

Excel 2016 Level 1
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Chapter 2: Creating worksheets

Using AutoSum to enter functions

AutoSum is a wonderful time-saving feature that allows you to enter functions like SUM() and AVERAGE()
in a single click. You can use AutoSum on a single cell, or to enter a similar function in a range of cells all at
once.

1. Select the cell or cells in which you want the function or functions to go.

2. Click the AutoSum button to enter the SUM() function, or click the button's drop-down arrow to select a

3. If necessary, edit the argument.

different function.

The AutoSum button is on the far right of the Home tab, in the Editing group.

Z Sum

Count Numbers
Max

Min

Moere Functions...

ZAutUSum - Aq, O

Average ect~

The function appears in the cell, with a guess at the range you want to use as the argument.

4. Press Enter.

If you selected a range of cells, Excel goes ahead and enter all the functions without a separate step for
editing the arguments. This gives you less control, but it gets a lot done quickly.

Exercise: Using AutoSum to enter SUM() and AVERAGE()
My Budget Functions is open.

Do This

How & Why

1.

2.

Select D16.

On the Home tab, in the Editing group,

click AutoSum.

Press Enter.

Select E16:F16.

Click AutoSum.

. Delete the contents of DS.

. Select G8:G16.

The Editing group is on the far right of the ribbon. Excel enters
the SUM() function, and guesses, correctly, that you want to
use D8:D15 as the argument.

Next, you'll enter the remaining SUM() functions in a single
step.

Excel enters the correct function in both cells with a single
click.

Select G8 and press Delete. You'll enter the remaining
AVERAGE() functions with a single click.

40
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Module C: Functions

Do This How & Why

Note: This method works

nicely when all of the data
are well ordered.
Sometimes, however,
trying to enter multiple

3 AutoSum - e\

> Sum

Average

Count Muibers

functions in this manner Excel enters the correct AVERAGE() functions in the entire
can lead to unexpected selected range.
results.

8. Click the drop-down arrow next to the
AutoSum button, then click Average.

9. Save and close the workbook.

The completed My Budget Functions workbook

GE x Fe =AVERAGE(BS:F8)

[ﬂ? B iz D E F G .
7 | Yearl  Year2  Year3  Yeard  Years Average
8 24000 24000 24000 25200 25200 24480
g 12000 2000 2000 2000 2000| 4000
10 5000 500 500 500 500 1400
11 3000 1000 1000 2000 1000 2800
12 12000 13200 14500 16000 176001 14660
13 4000 1000 1200 1400 1600 1840
14 60000 65000 80000 50000 100000/ 73000
15 10000 11000 12000 13000 14000 12000
16 136000 117700 135200 150100 161900 140120
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Module D: Moving and copying data

Exercise: Moving data in a worksheet

In this exercise, you'll open a workbook showing a year of a café budget, and move that data using a couple of
techniques.

Exam Objective: MOS Excel Core 2.1.3

Do This

How & Why

1.

2.

3.

4.

5.

6.

1.

Open Moving and Copying.

Move the budget info down three
rows.

a) Select A7:N16.

b) Click | 35 Cut |

¢) Select A10.

d) Click the Paste button.

On the Quick Launch toolbar, click
Select A7:N16.
Move the data down by dragging.

a) Point to the border of the selected
data.

b) Drag the data down a few rows.

Undo the move.

Save the workbook as My Moving
and Copying.

From the Creating Worksheets data folder. This workbook
contains a first-year budget for a café. We'd like to move the
budget info down a few rows.

The Cut button is on the ribbon's Home tab, in the Clipboard
group. A marquee appears around the cut data, telling you that
you've placed it on the clipboard, ready to move.

The Paste button is next to the Cut button.
ki
.
Paste

The budget data now begins in row 10.

This is the Undo button. Very useful. You can also press
Ctrl+Z to undo the last action. The budget moves back where
it was.

This time, you'll move the data down by dragging it.

This pointer shape, a four-headed arrow, tells you that you can
drag the data.

Dec  Year Tofal @

2000 iy

Simply release the mouse when the data is where you want it.
The data appears where you release the mouse.

Click the Undo button or press Ctrl+Z.

Excel 2016 Level 1
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Chapter 2: Creating worksheets

Copying data

Often, you want to create data that is identical to or similar to data you already have. For example, you'll
likely use similar labels for similar budgets. You can copy and paste data to avoid having to enter the same
information over and over.

Exam Objective: MOS Excel Core 2.1.2

1. Select the data you want to copy.

2. Click the Copy button, or press Ctrl+C.

3. Select the destination for the copied data.
4. Click the Paste button, or press Ctrl+V.

The data appears both in its original location and in the new location. The data is also still on the clipboard, in
case you want to put it somewhere else as well.

Copying data by dragging
Just as you can move data by dragging, you can copy it that way as well. The only difference is that you need

to hold down Ctrl while dragging. When you hold Ctrl and point to the border of selected data, the pointer
takes the shape of an arrow with a plus sign.

Exercise: Copying data in a worksheet
My Moving and Copying is open.

Exam Objective: MOS Excel Core 2.1.2

Do This How & Why
1. Select A7:N7. You'll make a copy of the budget monthly headings to use on
the other worksheets, which will contain budget data for years
2 and 3.
2. Click B Copy . The Copy button is on the Home tab, in the Clipboard group,

below the Cut button. A marquee appears, telling you that the
data has been copied to the clipboard.

3. Click the Year 2 worksheet tab. You'll paste the headings on this worksheet.
4. Sclect A7, and press Ctrl+V. The headings appear on this worksheet.
5. Activate the Year 1 worksheet. Click its worksheet tab. Notice that the headings are still there,

because you copied, rather than cut them. Also, the marquee is
still showing, meaning you can paste the copied headings

again.
6. Paste the copied headings onto the
Year 3 worksheet.
a) On the Year 3 worksheet, select A7.
b) Press Ctrl+V. The headings appear on this worksheet.
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Module D: Moving and copying data

Do This

How & Why

7. Update the workbook.

8. Activate the Year 1 worksheet.

9. Copy the monthly headings to row 20
by dragging.

a) Select A7:N7.

b) While holding Ctrl, point to the
border of the selected data.

¢) Drag the selected headings to row
20.

10. Drag a copy of the row headings in
A8:A16 below the new column
headings.

11. Save the workbook.

Copying formulas

Notice that the marquee is gone. When you save, the clipboard
is cleared. You can also clear it by pressing Esc.

If necessary.

The pointer takes the shape of an arrow with a plus sign.

Dec  Year Total |T *
2000 E

0

When you get where you want the headings, release the
mouse. A copy of the headings now appears in row 20.

Select them, point to the border while holding Ctrl, and drag
them down.

When you copy a formula that contains cell references, and then paste it into another location, Excel updates
the references in the pasted formula relative to the new location.

References in a copied formula
I

8 |=SUM(BE:ME)—h =
} EF Com
9 |=SUM(B9:M9) 3 Copy

Because the formula in N8 was moved down one row, Excel increases the row numbers in the pasted formula
by 1 each. So, B8 becomes B9, and M8 becomes MO. In this way, the formula continues to sum the values to
the left of it. This kind of reference is called a relative reference.

Excel 2016 Level 1
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Chapter 2: Creating worksheets

Exercise: Copying a formula in a worksheet

My Copying and Pasting is open. You'll copy formulas and observe how references are updated when you do.

Do This

How & Why

1. In N8, enter a function to calculate the

You can use AutoSum, or enter the function manually,

sum. =SUM(B8:M8).
2. Copy N8 to N9. Select N8, copy it, select N9, and paste.
3. Select NO9. Notice that the pasted formula refers to B9:M9. These are the

correct references relative to the new location of the formula.
That's because Excel uses relative references by default. When
you paste a copied formula, Excel updates the references in the
new formula.

4. Copy N9 to N10:N15.
a) Select N9.
b) Copy.
¢) Select N10:N15.

d) Pastc. You can copy from one cell and paste into a range of cells in a
single paste step.

5. In B16, calculate the Jan sum. Use the SUM() function.

6. Copy B16 to C16:N16. Select B16, copy it, select C16:N16, and paste.

7. Select N16. Because this cell is 12 columns to the right of the copied cell,

Excel changed the references from B8:B15 to N8:N15.
Column N is 12 columns over from column B.

8. Save and close the workbook.

The completed budget
. A W 2 [ E | G I J K L M N
7 Expense Jan Febh Mar Apr May Jun Jul Aug Sep Oct Nov Dec  YearTotal
8 |Rent 2000 2000 2000 2000 2000 2000 2000 2000 2000 2000 2000 2000 24000
9 |Remodeling 10000 0 o 0 o o 2000 o o o o 0 12000
10 |Legal 4000 500 o 0 ] ] o 500 1] 1] 1] o 5000
11 Egquipment 8000 1000 0 1] o o 0 0 0 0 0 a 9000
12 Supplies 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 12000
13 | Advertising 3000 100 100 100 100 100 100 io0 100 100 100 100 4100
14 Payroll 5000 5000 5000 5000 5000 5000 5000 5000 5000 5000 5000 5000 60000]
15 |Miscellaneous 800 800 800 800 800 800 800 800 800 800 800 800 9600
16 Totals:: 3380[;: 10400 8300 3500 3500 8500 10500 5400 8300 8300 8300 8900 135700
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Chapter 2: Creating worksheets

Exercise: Experimenting with the limitations of relative references

In this exercise, you'll predict future years' values in a budget by using multiplier percentages. Then you'll
copy those formulas to see the limitations of relative references.

Exam Objective: MOS Excel Core 4.1.1

Do This

How & Why

1. Open Reference Types.

2. In C8, enter =B8*I8.

3. Copy C8 to DS:F8.

4. Select DS.

From the current data folder. This is a version of the café
budget, projecting for five years. You're going to use the yearly
modifier percentages in column I to project the future figures
for rent, supplies, and payroll.

The formula calculates the projected rent for Year 2.

There is a problem with the copied formulas. D8, E8, and F8
all display 0.

In the copied formula, the reference to B8 was correctly adjusted to C8. But Excel also adjusted the
reference to the multiplier in I8, which is now referring to J8, a blank cell. Relative references always
adjust relatively to their new location, and when you have single values like a multiplier, that's not

what you want to happen.

AVERAGE ~ X v & —£B*13
= D E G H | ]
i Year2 Year3 Yeard Years Increase
g | 24a960l=cs*iz | 0 0 104%| I
] 2000 2000 2000 2000

5. Undo the pasting of the formulas and
the entry of the formula in C8.

6. Save the workbook as My
Reference Types.

52

Excel 2016 Level 1



Chapter 2: Creating worksheets

Exercise: Using an absolute reference in a formula

The My Reference Types workbook is open. You'll use an absolute reference in a future year projection
formula, then copy that formulas to the remaining year's projections.

Exam Objective: MOS Excel Core 4.1.1

Do This How & Why
1. Enter the projection formula in C8. This time, you'll use an absolute reference to the projection
percentage.
a) In C8, type =B8*. But don't press Enter yet.
b) Type $1$8. To enter an absolute reference to cell 8.

¢) Enter the formula.
2. Copy C8 to DS:F8. The results now look good.
3. Select DS. In the copied formula, the relative reference to B8 was
adjusted to C8, but the absolute reference to $I$8 was not

changed, so the formula is correct.

4. Enter the projection formula in C12.

a) In C12, type =B12*I12. This time, don't type the dollar signs. And don't press Enter
yet.
b) Press F4. The reference to 112 changes to absolute, "$1$12."

¢) Enter the formula.

5. Copy C12to D12:F12. The projections for supplies are correct, because the absolute
reference to I12 is not being adjusted in the copied formulas.

6. Save the workbook.
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Chapter 2: Creating worksheets

Exercise: Using a mixed reference in a formula

My Reference Types is open. You'll see a limitation of an absolute reference and use a mixed reference to get
a better result.

Exam Objective: MOS Excel Core 4.1.1
Do This

How & Why

1. Copy C12 to C14.

. Select C14.

. Undo the copied formula.

. Delete the Rent and Supplies

projection formulas.

. In C8, enter the projection formula.

a) In C8, type =B8*1I8.

b) Press F4.

¢) Press F4 again.

d) Press F4 again.

¢) Enter the formula.

. Copy C8 to DS:F8.

. Copy C8to C12:F12.

. Copy C8 to C14:F14.

. Save and close the workbook.

On the surface, this looks reasonable as a projection for payroll
m Year 2.

The formula is using 112 as the multiplier, because the formula
uses an absolute reference to it. You actually want the
reference in the copied formula to be in the same column, but
to a different row. This is a perfect case for using a mixed
reference.

In C8:F8 and C12:F12. By using a mixed reference, you're
going to make a single formula in C8 that can be copied to all
the projections.

Don't press Enter yet.

The reference changes to absolute, "$I$8," which is not what
you want.

Now, you have a mixed reference, "I$8." If you use this, when
the reference is copied, the column letter will adjust, while the
row number will stay fixed. That's not what you want.

This is the mixed reference you want, "$I8." When this is
copied, the column letter will stay fixed, but the row will
adjust relatively to the new location.

The formula works well when copied.

The formula also works when copied here. The mixed
reference to $1I8 changes relatively to the row, but the column
stays fixed, giving the correct $112 reference.
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